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Overview”

Perspective Workflow" is a business activity monitoring application that works behind the scenes
to help you stay on top of Perspective’s reported incidents, ongoing investigations and current

assignments. It monitors and auto-responds to critical, time-sensitive data, automatically notifying
the necessary personnel and guiding team members through the proper processes and protocols.

To get Perspective Workflow up and running, please follow the instructions provided throughout
this guide, in order of appearance.

Minimum System Requirements

Web Services Server

Available Disk SpaceT
) 1GB

Processor Speed
. Minimum: 2 GHz

. Recommended: 3 GHz+

Memory

. Minimum: 1 GB

o Recommended: 2.5 GB+

Operating System

e Minimum: Windows Server® 2003 with SP 1

. Recommended: Windows Server 2003 with SP 2

.NET Framework

. Version 3.5SP 1

I1S (Internet Information Services)

. IIS 6.0, WSE 3.0

* This document is only applicable to organizations that have purchased Perspective Workflow,
an optional module for Perspective by PPM 2000. If you are not certain that your Perspective
system includes Workflow, please contact Customer Service for verification.

T Depending on the size of your Perspective database, more disk space may be required.
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Database Setup

The Perspective Workflow database setup procedure depends on what version of Perspective
your organization is using and whether the Workflow setup is new or existing. Refer to the
appropriate procedure of the three below to correctly setup your database.

New Workflow Setup — Perspective 4.0 and Later

Follow this procedure if setting up Workflow for the first time and using Perspective 4.0 or later.
1. Open Microsoft® SQL Server® Management Studio.

2.  Run the database views script PWFDataViews_v2.0.sql against the Perspective database
being used with Perspective Workflow.
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ODBC Connection Setup

1.

Select Start > Administrative Tools > Data Sources (ODBC).

Note: Perspective Workflow uses the 32 bit ODBC manager regardless of whether you are
running Workflow on a 32 bit or 64 bit machine. On 64 bit machines, the 32 bit ODBC device
manager is typically located in the %winDrive/Windows/syswow64 directory and can be run
by executing ODBCAD32.exe.

Select the System DSN tab and click Add.

£l ODBC Data Source Administrator

ser DSM  Spstem DSM l File DSM ] Dlivers] Tlacing] Connection F'ooling] About ]

Syztem Data Sources:

Name | Driver | Add...

Femove

Configure...

An 0ODBC System data source stores information about how to connect to
the indicated data provider. & Systemn data source iz visible to all uzers
on thiz machine, including NT services.

0K | Cancel | Help

Select SQL Server and click Finish.

Create New Data Sournce El

Select a driver for which vou want to set up a data source.

[RENN | WA
Microzoft QDBC for Oracle
Microsoft Parados Driver (“.db )
Microsoft Parados-Treiber (*.db )
Microzoft Tewst Driver [*.tat; " cav)
Microsaft Test-Treiber [ tat; ".cav]
Micrazoft Visual FosPro Driver
Microzoft Visual FosPro-Treiber

Mg = — e e e PO

|

e
|

| Finizh [:: | Cancel




Perspective Workflow Installation Guide

Enter a Name and Description for the ODBC connection; select the name of the SQL
server that hosts your Perspective database; and click Next.

Create a Mew Data Source to SOL Server E|

This wizard will help pou create an DDBC data source that pou can uze o
conhhect bo SAL Server.

What name do you want to uge to refer to the data source?

MName: |Wnrkf|u:uw ODBC Connection]

How do pou want to describe the data source?

Dezcription: |

Which SOL Server do you want o connect ta?

Server |BETA'\SQLE:-:|:|ress ﬂ

Finizh | Mext » % Cancel Help |

Choose the authentication mode you want to use for the ODBC connection (Windows
authentication or SQL authentication), and click Next.

Create a Mew Data Source to SQL Server [$__<|

Howw should SOL Server werify the authenticity of the login 107

i+ Mfith Windows NT authentication uzsing the network login D

With SOL Server authentication using a login 1D and password
enterad by the uzer.

To change the network, library used to communicate with SAL Server,
click Client Configuration.

Chent Configuratian...

v Cannect to SOL Server to obtain default zettings far the
additional configuration options.

< Back | Mext » [T\:l Cancel Help
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6. Selectthe Change the default database to box and choose the name of your Perspective
database from the list below.

Create a Mew Data Source to SQL Server E|

[v Change the default databaze to:
Perspective Sample j

[ Attach database filename:

Iv¥ Use ANSI quaoted identifiers.
[v sze AMSI nulls, paddings and warnings.

-

< Back | MHest > E! Cancel Help

7. Ensure the Use ANSI quoted identifiers and Use ANSI nulls, paddings and warnings
boxes are selected, and click Next.

8. Click Finish.

x)

Create a Mew Data Source to SOL Server,

[ iChange the language of SOL Server system messages tos

| [

[~ Use strong encryphion for data

[v Perform translation for character data

= Uze regional settings when outputting currency, numbers, dates and
times.

| Save long running queries to the log file;

Long query time [milizeconds):

[ Log ODBC driver statistics ta the log file:

| [ o=, |
< Back | Finizh &l Cancel ‘ Help |
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9. Click Test Data Source.

ODBC Microsoft SOL Servern Setup

A new ODEC data zource will be created with the following
configuration;

3

Microsaft SCL Server ODBC Driver Yersion 03.86.3959

Data Source Mame: wWiorkflow ODBC Connection
[ata Source Description:

Server: BETAMSOLE #press

Databaze: Perzpective_Sample

Language: [Default)

Tranzlate Character Data: Yes

Log Long Running Quernies: Mo

Log Diriver Statistics: Mo

Ilze Integrated Securty: Yes

|lze Regional Settings: Mo

Prepared Statements Option: Drop temporary procedures on
dizconnect

|Jze Failover Server: Mo

dze AMSI Quoted |dentifiers: Yes

Jze AMSI Mull, Paddings and ' armings: ves
Drata Encryeption: Mo

Test Data Source... C% ] | Cancel |

10. When the data source connectivity test is complete, click OK.

SOL Server, ODBC Data Source Test

Test Resultz

%]

Microzoft SOL Server QDBC Driver Verzion 03.86.3353
Running connectivity tests.

Attempting connection

Connection eztablizhed

Yenifying option settings

Digconnecting from server

TESTS COMPLETED SUCCESSFULLY!
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1. Perspective Workflow InstallationDouble-click the PW_Setup_V82d.msi file located inside
the Installation Files v1.0 folder; then click Run.

Open File - Security Warning |

The publisher could not be verified. Are you sure you want to
run this software?

Mame: ...orkflow\Installation Files v1.0\PW_Setup_V7&.msi
Publisher: Unknown Publisher
Type: Windows Installer Package
From: C:\Perspective Workflow\Installation Files v1.0\FW...

Fun | Cancel I

[V Aways ask before opening this file

publisher. You should only run software from publishers you trust.

| s | This file does not have a valid digital signature that verfies its
¥ How can | decide what software to nn?

2.  Click Next.

it Perspective Workflow Setup o ] [ |

Welcome to the Perspective
/ Workflow Installation Wizard

It iz strongly recommended that you exit all Windows programs
before running this eetup program.

Click Cancel to quit the zetup program, then close any programs
you have wnning. Click Mest to continue the installation,

WARMIMG: This program is protected by copyright law and
international treaties.

Unauthorized reproduction or distibution of thiz program, or any
portion of it, may result in severe civil and criminal penalties, and
will be prozecuted to the marimun extent possible under law.

< Back Cancel
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3. Select the | accept the license agreement radio button, and click Next.

i'-.a Perspective Workflow Setup

License Agreement

Y'ou mugt agree with the license agreement below to procesd.

Plea=se =ees PPM 2000 Inc. Software Licence Agreewment for
Term=s & Conditions of use.

+ || accept the license agreement

| do nat accept the license agreement

Wize Inztallation wWizard®

Hezet ¢ Back HiEwt = Cancel
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4. Read the installation information, and click Next to begin the install.

i'.‘% Perspective Workflow Setup

Readme Information

The following information describes this installation.

FPM 2000 Inc. Perspective Workflow V1.3 (build 8.2d) HNotes
August 4, 2013

You must have ODBC installed on all computers that will use
Perspective Workflow. You must also have a unigue ODBC
source for each application that you wish to create inside
Perspective Workflow.

Before you can access PPM 2000 Imc. Perspective databases
within Perspective Workflow, vou must first create a unigque
System Data source name (DSH) pointing to yvour PPM 2000
Inc. Perspective SQLServer Database.

Wize Installation Wizard®

< Back I MHest » I Cancel

5.  Enter your user information, and click Next.

i'.‘% Perspective Workflow Setup

User Information

Enter the following information to personalize vour installation.

Full M arme:

Organization: PP 2000 e,

The zettings for this application can be inztalled for the curent uzer ar for all uzers that
zhare thiz computer. 'ou must hawve administrator rights to install the zettings for all
uzerz. Inztall this application for:

' Anwone who uses this computer

= Only for me [Testing]

Wize Installation Wizard®

< Back I Mest » I Cancel
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6. The default install destination will be displayed. (If a different location is preferred, use the
Browse button to navigate to the chosen location.) Click Next.

fi Perspective Workflow Setup

Destination Folder

Select a folder where the application will be installed.

The “Wize [nstallation ‘Wizard will install the files for Perspective \Warkflow in the following
folder.

Toingtall into a different folder, click the Browse button, and select another folder.

Y'ou can choose not to install Perspective ‘Workflow by clicking Cancel to exit the 'Wis. ..

Destination Falder
’VI::"'.F'rI:ugram FilegPPR 2000 [nchPerzpective 'warkfow', Browse |

Wize |nztallation ‘Wizard®

Cancel |

10
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7.  Accept the default settings for all components by clicking Next.

Note: Remote Perspective Workflow clients must be individually licensed in order to run the
Workflow application. If you install one or more remote Perspective Workflow clients, you
must only install the core and client components on each remote client. You will not need to
specify the location of the Workflow database during the installation process; the first time
that a remote client is executed, the user will receive a browse button allowing them to
locate the Workflow database.

i'él Perspective Workflow Setup

Select Features

Pleaze zelect which features you waould like to instal,

Feature Description:

Select thiz feature if the zervers and databasze
will be installed an thiz computer. Do not zelect
thiz feature if the databaze and servers are
located on another computer on the network.,

Thiz feature will be installed on the local hard
drive

Thiz feature requirez 175MB on pour hard
drive.

Browse |
Wize [nztallation \Wizard®
Dizk Cogt Bezet ¢ Back | Mest = I Caricel |

11
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8.  Click Next to begin the installation.

i'._% Perspective Workflow Setup

Ready to Install the Application

Click Mest to begin inztallation.

Click the Back button to reenter the installation infarmation or click Cancel to exit
the wizard.

Wize Ihztallation \Wizard®

¢ Back | et = I Cancel

Note: The service needs to run using an account that has local admin rights to the server
where workflow is installed.

12
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9. If prompted to confirm the installation, click Yes.

ﬁ_!l User Account Control

| ﬁl Do you want to allow the following program from an unknown
“* publisher to make changes to this computer?

Program name:  C:\PW _Setup_Va2d\PW_Setup VE2d.msi

Publisher: Unknown
File origin: Downloaded from the Internet
j Show details Yes Mo

Change when these notifications appear

13




Perspective Workflow Installation Guide

i Perspective Workflow Setup

Updating System

The features you selected are currently being installed.

|lpdating component registration

H

Wize Inztallation Yizard®

Cancel

10. Click Finish once the installation is complete.

{5 Perspective Workflow Setup 0] x|

Perspective Workflow has been
7 successfully installed.

Click the Finizh button to exit thiz inztallation.

< Back | Finizh I Canzel

14
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IM Installation

There are two IM installations: IM32 (for 32 bit machines), and IM64 (for 64 bit machines). As IM
is optional, only install it if you will use it.

The IM Accounts option enables you to configure and maintain the Instant Message accounts
from which you will send notifications. Note that you can configure multiple IM accounts using
multiple IM methods, such as Windows Live Messenger, Google Talk, and ICQ, so that you can
receive IM alerts via one method while at work and via a different method while at home.

It is suggested that prior to setting up this account that you send IM “invitations” to all the
recipients. Note that some IM providers (e.g., Windows Live Messenger) requires an IM recipient
to “accept” invitations from an account before the messages can be successfully delivered,
whereas other IM providers (e.g., ICQ) require “invitations” but do not require recipient
acceptance.

1. Double-click the PW_Setup_V82d.msi file located inside the Installation Files v1.0 folder;
then click Run.

Open File - Security Warning |
The publisher could not be verified. Are you sure you want to
run this software?
Mame: ...orkflow\Installation Files v1.0\PW_Setup_V7&.msi
Publisher: Unknown Publisher
Type: Windows Installer Package
From: C:\Perspective Workflow\Installation Files v1.0\FW...

Fun | Cancel I

[V Aways ask before opening this file

publisher. You should only run software from publishers you trust.

lel This file does not have a valid digital signature that verfies itz
%" How can | decide what software to un?

Windows Installer

Ad| Preparing to install...
==

15
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_Ad| Please wait while Windows configures IM SDK
155

Gathering required information. ..

Extracting Files X

Exdracting File: Minstall .exe
Ta Directony: cAd7h937a1f0d 31 0c0fbabBhS 702 1de 359

16
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Licensing & Server Login Information

1. Open the Perspective Workflow Administrator. The application can generally be accessed
through Start > Programs > Perspective Workflow > Administrator.

2. Inthe logon window, enter your administrator User Name and Password, then click OK.
(The default User Name is Admin and the default Password is master.)

w_ Perspective Workflow Administrator |

Uszer Marme: I.-'l'-.l:lmin

Pazaword: |******

k. Cancel |

3. Under the Help menu, select About Perspective Workflow Administrator.

& Perspective Workflow Administrator

J_| File View IE
“@ Print ‘ Contents

Activity

PPM 2000 Inc. on the Web

About Perspective Workflow Administrator. ..

IE ------------ ﬁ Activity

f— P Sorver Status b

4. Click the License button.

i, About Perspective Workflow Administrator ' x|

Ferzpective workflow Administrator

‘\_\: PBTSPE ':tilue- Version 2000.8.2d

By PP IE

Thiz application is licensed to:

B Workflow~ et

PPM 2000 Inc Perspective Work o g |
Copyright [c] 1998-2013, Yinepardzoft Corporation. All Rights Reserved.

“wharning: This software product is protected by copyright law and
international treaties.

Licenze...

B azic Scripting provided by Cypress Software, Ihc. [c] 2013
Swyztem Info...

17
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5.  Enter the license information provided to you by PPM 2000 and click OK, then OK again.

ini. Perspective Workflow - License Code Management x|

License Owner: ILINLIEENSED -FOR EVALUATION PURPOSES OMLY
Licenze Expiration Date: |4,.-"| R2010

License Code: IB#EEBDEF.-’-‘-.EBMDDS?D
Licerse Type: IENTEFEF'FEISE-WEEE.-‘E.STEFE j
Lizenzed Server Mame: IEEPWH‘I 2003514

Licenzed DB Connections: I
k. | Cancel |

6. Click the Server Login Information button on the toolbar.

&1 Perspective Workflow Administrator

JJEiIe Wiew Help

“% Prirt | (2 Server Login Informstion

D I Server

7.  Enter your administrator User Name and Password, then click OK. (The default User Name
is Admin and the default Password is master.)

Note: If the fields are pre-populated, delete the values and re-enter your login information.

i, Perspective Workflow Administrator - Server Login Inforn x|

Uszer Mame: I!-'-‘-.u:lmin

Pazsword: |**“***

k. Cancel |

8. Close the Perspective Workflow Administrator; then, start the Perspective Workflow service
in Computer Management.

18




Perspective Workflow Installation Guide

Email Setup

1. Open the Perspective Workflow Administrator. The application can generally be accessed
through Start > Programs > Perspective Workflow > Administrator.

2. Inthe logon window, enter your administrator User Name and Password, then click OK.
(The default User Name is Admin and the default Password is master.)

. Perspective Workflow Administrator - Server Login Inform x|

Uzer Marme: I!-'l'-.u:lmin

Pazzword: |>=x>""‘x

Cancel |

3. Expand the Software Setup node, click Email Accounts and click the New Email Account
button in the top-left corner of the window.

& Perspective Workflow Administrator

| Ele Edit view Help

59 Mew Email Account Print | ¥ Delete | %8 Perform Email Test
A | & it | |

VT | Software Setup
Carrective Action
Hardware Setup Administration Folders Ermail Accounts

Software Setup | || 5 ﬂ Activity | ID | Deseription | Email Type [ Dawricad Emai l
E Server Status
-8 Cunent User Logins
0 Corrective Action
Hardware Setup
[l Softwane Setup
e =
& Fax Accounts
% Fax Cover Pages
A% Holiday Schedule
(L} IM Accounts
-..[Bll Paging Services
& Twitter Accounts

g Webcast Locations
‘;ql User Access

[l
)

Holiday Scheduls

4.  Select INTERNET for the Email Type field; populate the Email Account Description,
Outgoing Mail (SMTP) Server Name and SMTP From Name fields (the SMTP From
Name field must be populated with a valid email address); ensure that the Active box is
checked; and click Save and Close.

Note: You must create a separate Perspective Workflow email account for each email
address that you want email naotifications to be delivered from. For instance, if you would like
employees in different departments to receive email notifications from different email

19
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accounts, you must create a Perspective Workflow email account for each department.
(Keep in mind that each event can only use one email account to send notifications from.)

B perspective Workflow - Email Accounts

File Edit Help

[ Save and Close ] Save and New | W Delete | 4 Previouz ~ W Mext -

E mail Account Description;

General T Dial-lp Metwarking T Email Besponze Syatem Optiohz [Ihcoming) T Higtary ]

Internal D Aumber; I

Email Type: |INTEF|NET | EharacterSet:l =]

E mail Account Description; IPergpecti\;E whark flaw

Login Mame, kailbox ar Profile Manme: |

Password: |

Pozstoffice [Exchange, Motesz ar Wik only]: |

v Active
— SMTF/POF Internet Email Infarmation:

Cutgaing mail [SMTR) server nanme: Imail._l,lcuurISF'.net

SMTP From Mame [required for INTERMET]: IPerspective Whorkflow <mailname@ ' ourD amain. coms:
SKMTPF Port [optional]: I

|nzoming mail [FOP] server name: ||

POP Fart [optional]; I

M otes:

5.  Close the Perspective Workflow Administrator.

IM Setup

1. Open the Perspective Workflow Administrator. The application can generally be accessed
through Start > Programs > Perspective Workflow > Administrator.

2. Inthe logon window, enter your administrator User Name and Password, then click OK.
(The default User Name is Admin and the default Password is master.)

20
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3.

21

Expand the Software Setup node, click IM Accounts.

&1 Perspective Workflow Administrator
|| Eie Edit view Help

H-Tfl News IM Account | & Print ‘ 7 Delete | %8d Perform IM Test
Activity Software Setup

Corrective Action

Hardware Setup | b Administration Folders M Accounts
Software Setup [ |5 ﬁ Activity ID | Description | I
-------------- E Server Status
-------------- H5 Curent User Loging

E [ 0 Corrective Action

Email Azcounts [ i Hardware Setup
(B g Software Setup

e = Email Accounts
.............. @ Fax Accounts
-------------- % Fax Cover Pages
-------------- @3 Holiday Schedule

27

& Paging Services
-------------- = Twitter Accounts
-------------- g ‘webcast Locations
[ e :’q]_ Uszer Acoess

Service Provider: Select from Windows Live Messenger, Google Talk, Yahoo! Messenger,
and ICQ.

Account Description: A description of the account that will be used for sending IM
notifications.

Username: The user name for this IM account. Note that different IM methods (such as
Windows Live Messenger and ICQ) require different types of login information. Typically,
Windows Live Messenger uses an email address whereas ICQ uses a unique numeric
identifier. Please refer to the documentation/help text for your preferred IM provider for
details.

Password: The password of this IM account.

Active: Whether this account is currently available for sending IM alerts (you can configure
an account without enabling it for immediate use)

Note: Each IM alert message may not exceed 1,500 characters (including spaces) in length.
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& Perspective Workflow - TM Accounts

Windows Live Messenger -

22
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Perspective Workflow Event Pak Installation

1. Open the Perspective Workflow Event Manager. The application can generally be accessed
through Start > Programs > Perspective Workflow > Event Manager.

In the logon window, enter your administrator User Name and Password, then click OK. (The
default User Name is Admin and the default Password is master.)

. Perspective Workflow Event Manager EI

Uzer Mame: I.-'-‘-.u:lmin

Pazzword: |>=*><**>1

k. Cancel |

[Type a quote from the document or the summary of an interesting point. You can position the
text box anywhere in the document. Use the Drawing Tools tab to change the formatting of the
pull quote text box.]

2. Under the File menu, select Event Pak then click Install.

r[!ﬂ Perspective Workflow Event Manager
JJ| File ¥iew Help

EventPak »

Vendor Identification. ..

Builder...

Install...

License Generator...

23
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3.

Browse to the location of the PerspectiveWorkflowEventPak_v2.0.kse file (included in the
Event Pak folder); then, click Open.

Perspective Workflow - Select EventPak to install 2=l

Look in: I&}Base Ewvent Pak w1.0 j - |‘=_'°F '

File name: IF'erspectiveWnlkflanaseEventF'ak_ﬂ Okge j Open

o

Files of type: | EventPaks [*kse] | Cancel |
4

pen az read-only

Click Install.

. Perspective Workflow - EventPak Installation 1Ol =l

EventPak Description
Company

Sales Contact Mame:
Sales Phone Mumber

Sales Email Address

: IF'erspective “Workflow Baze Event Pak +1.0
© |PPM 2000 Ine.

: ISaIes

: |1-888-??E-8??E Option 1

: |Infc-rmatiu:-n@p|:-m2UElD.-:c-m

Sales Website Address: Iht[p; Atveawy. ppm 2000, com
EwentPak Wersion: I'I.D
EwentPak Release Date: |3;-| 5/2010
Iristallation Mates:

The following Application(s] will be installed into the Database

Destination Folder/&pplization [Click for dropdown list]

Applization
| AP erzpective Conrnection

Inztall az new application into folder-> Application Events

Imztall |

Cancel |
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5.

7.

25

When the Finished message appears at the bottom of the window, click Close.

Perspective Workflow |

Reloading, pleaze wai...

Select the Perspective Connection event pak under the Standard Event Pak node; then,
click the Properties button.

-f!ﬂ Perspective Workflow Event Manager

JJ_HE View Help
|| @ erint | X peete | B! Properties

é | Event Management Folders
- @ & pplication Events

Application Events Standard Event Pak -
\"J Standard Event Pak - Admin
\Q] Standard Event Pak - Azzignments - General
\Q] Standard Event Pak - Cazes
\Q] Standard Event Pak - elncidents
\Q] Standard Event Pak - [tems
\Q] Standard Event Pak - Organizations
\Q] Standard Event Pak - Personz
3] Standard Event Pak -Yehicles
I-H8 Subscribers

Actiities

With Perspective Connection selected in the Connection to Use For Database Access
field, click the Edit Connection button.
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. Perspective Workflow - Standard Event Pak - Activities Properties Ol x|

Standard Event Pak - Activities

26
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8. Inthe ODBC Data Source Name (DSN) field, select the ODBC connection that you created
in the ODBC Connection Setup phase of this installation process; click Save and Close;

and then click OK.

Note: If SQL authentication was used for the ODBC connection, you must also enter your

SQL credentials in the Username and Password fields.

Perspective Workflow - Edit Connection...

File Edit Help

I save and Close | ¥ Delete

Connection Description:  Perspective Connection

General T Hiztary ]

Internal [0 Aumber;

QDBC Data Source Mame [DSH];

sername:

Paszsword:

[ ate Separation Character:

Long Tablename LEFT Character:
Long Tablename RIGHT Character:

Colurnn &liaz Character:

Script &P Mame:
Script AP Username:
Script AP Password:

IE ES_PERSPECTIVEDefault

Connection D escription: |Perspective Connection

Mone [Specify Driver Information)

v

|
|
=
=
=
I.._

R
R

I1ze Coordinated Univerzal Time [UTC] for DatesTimes

Link.Aloin prefix [Dptional]: I
Link.AJoin zuffiz [Optional): I

etrieve Databaze Dwner with objectz if available.

emove parenthezes from LinkAains

-

117101 A
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Subscriber Configuration

In Perspective Workflow, individuals who receive email notifications when events are triggered
are known as "subscribers." Each event must have one or more subscribers associated with it,
but before you can choose subscribers for each of your events, you must either manually create
subscriber records within Perspective Workflow or link user records in your Perspective database
to Perspective Workflow’s subscriber list.

Note: Subscriber linking is dynamic; in other words, updates to your Perspective user records will
automatically be reflected in your Perspective Workflow subscriber list.

For more information on subscriber configuration, please refer to the Subscriber Maintenance
section of the Perspective Workflow User’s Guide.

Manually Creating a Subscriber

1. In Perspective Workflow Event Manager, expand the Subscribers node and select Users.

-f!ﬂ Perspective Workflow Event Manager

JJ File View Help
JJE MNew Group | ﬁ MNew Folder | % Print
Events Subscribers
Subzcribers

Standard Event Pak - Activities
| Standard Event Pak - Admin
4| Standard Event Pak - Agzignments -
\’J Standard Event Pak - Cazes
\’J Standard Event Pak - elncidents
\’J Standard Event Pak - lkems
\’J Standard Event Pak - Organizations
| Standard Event Pak - Persans
\g'] Standard Event Pak - Wehicles
=& Subscribers

ﬁ Computers

(- T

2.  Click the New Group button in the top-left corner of the window.
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3. Enter a Description for your group; then click OK.

wi. Perspective Workflow - Properties

=10l x|

Descriphion: |k anagement

Ok

4.  Select your new group under the Users node, and click the New User button.

-f.tﬂ Perspective Workflow Event Manager

JJ_HE Edit Wiew Help
Hiﬁuewuﬂr|§5m|xgeme|pmpem

[ Evens Subscribers

Subzcribers

! g Ewent ki anagement Folders
L——_Ifjé Application Events
| Standard Event Pak - Activities
| Standard Event Pak - Admin
| Standard Event Pak - Azzignments -
| Standard Event Pak - Cases
| Standard Event Pak - elncidents
\3] Standard Event Pal: - ltemns
| Standard Event Pak - Qrganizations
| Standard Event Pak - Persons
;g] Standard Event Pak. - Wehicles
=8¢ Subscribers
ﬂ Computers
-8 Users
----- & Perspective Investigators
----- & Perspective Supervisors
----- # Perspective Users
k anagement

29
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5. Complete the Last Name and First Name fields, and check the Active box. (The Full
Name field will automatically populate.)

ﬁ Perspective Workflow - Subscribers\Users\Perspective Users

File Edit Help

[ save and Close i) Save and New | > Delete | 4 Previouz ~ W Next -

Subscriber Mame;

Description |Eu:up_l,l| EmaiII Fa:-:l F'agel 'W'el:uEaslI InstantMessageI Sul:usu:riptiu:unsl

Internal 1D number: I

Last M arme: ISmith

First M arne: IJ ane

Full M arne: IE rith, Jane

Job Title

Compaty Mame

Phone Mumber

IP Address

Computer Mame: I

zer Lookup Key: |5M|THJ
[~ Active

— History:

[temn created by

[temn created on

[tem lazt changed by

Itern last changed on

<< Hack Hewt »x | Cancel Help

6. Select the Email tab, specify the subscriber’s primary email address in Email Address 1
and, if applicable, enter their secondary email address in Email Address 2.
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7. Indicate which email address (1 or 2) should be used on various days of the week and times
of day to notify the subscriber of an event’s occurrence. To indicate that both addresses
should be used in a given time slot, enter an asterisk (*), or you may leave the slot blank to
indicate that neither email address should be used. Alternatively, you can click the Use
Address 1 for All, Use Address 2 for All, or Use Both for All buttons to quickly apply
settings to all time slots.

ﬁ Perspective Workflow - Subscribers\Users\Perspective Users

File Edit Help

& save and Close g Save and New | . Delete | 4 Previous ~ 4 Hext -

Subscrber Mame: Smith, Jane

Descriptiu:unl Copy  Email |Fa:-:| F'agel 'W'el:uEastI |Fiztant Messagel Subscriptions

Email Address1: Iismith@acmecnrp.cum

Email Addressz2: Iismith@acmecnrp.cun‘l

Fleaze select which Email Address to use at the specified time:

1=Email Addrezs 1, 2=Email Addrezz 2, * = Both, Space Bar for Hone

Segment| Sunday konday Tuezday |‘Wednesday [ Thursday Friday Saturday

4 12:00 &4 2 2 2 2 2 2

12:30 &M

1:00 &M

1:30 AW

2:00 AW

2:30 AW

3:00 &M

3:30 AM

4:00 AW

4:30 AW

5:00 &M

5:30 AM

Pl | Pl | P [ Pl [ Pl | Pl | Pt [ Pl [ Pl | Pl | P | To0
Pl | Pl | P [ Pl [ Pl | Pl | Pt [ Pl [ Pl | Pl | P | To0
Pl | Pl | P [ Pl [ Pl | Pl | Pt [ Pl [ Pl | Pl | P | To0
Pl | Pl | Pt [ Pl [ Pl | Pl | Pt [ Pl | Pl | Pl | P2t | ol | To0
Pl | Pl | P [ Pl [ Pl | Pl | Pt [ Pl [ Pl | Pl | P | To0
Pl | Pl | P [ Pl [ Pl | Pl | Pt [ Pl [ Pl | Pl | P | To0
Pl | Pl | P [ Pl [ Pl | Pl | Pt [ Pl [ Pl | Pl | P | To0

B:00 Ak

Flestore Defaults | lze Addresz1 for Al | ze Address2 for All | lze Bath far All

<< Back | Meut = | Cancel | Help |

8. IM Setup for Subscriber: Select the Instant Message tab, select the Instant Message
Service Provider, and finally, select the IM Username of the subscriber (the person who will
be receiving the IM notifications).

31




Perspective Workflow Installation Guide

@ Perspective Workflow - Subscribers\Users\Perspective Users |
File Edit Help
[ save and Close i) Save and New | W Delste | 4 Previous ~ 9 Next ~
Subscriber Mame: Smith, Jane
Descriptiunl Eu:up_l,ll EmaiII Fa:-:l F'agel ‘WebCast Instant Message Subscriptiunsl
Instant Message Service Provider 1: |Winu:|u:uws livve LI
Instant Message Username 1: Iiane.smith

|nztant bMeszage Service Provider 2 | LI

Ingtant Meszage Username 2: I

Pleaze select which Mame to uze at the specified time:

1=Mamel, 2=Mamez, * = Both, Space Bar for MHone

Segment

Sunday

b onday

Tueszday

Wednesday

Thurzday

Friday

Saturday

4 12:00 AW

o]

2

2

2

o]

2

12:30 AM

1:00 AM

1:30 AM

2:00 A

230 AM

3:00 AM

330 AM

4:00 AM

4:30 AM

Pl | Pl | B0 | Pl [ Podt | Podr | P ol | T2

Pl | Pl | B0 | Pl [ Podt | Podr | P ol | T2

Pl | Pl | B0 | Pl [ Podt | Podr | P ol | T2

Pl | Pl | Pt | Pl | Pl | Pt | Pl | Pl | Pl | P2

Pl | Pl | B0 | Pl [ Podt | Podr | P ol | T2

Pl | Pl | B0 | Pl [ Podt | Podr | P ol | T2

Pl | Pl | B0 | Pl [ Podt | Podr | P ol | T2

Restore Defaults |

Ilze Mamel for Al

Jze Mame far Al |

|1ze Both for All

<< Back

Hewt ==

Cancel |

Help

9. Click Save and Close.

10. Continue to apply these steps to manually create additional subscribers as needed.
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Linking a Subscriber Group

1. Inthe Perspective Workflow Event Manager, select one of the default groups under

Subscribers > Users (i.e., Perspective Users, Perspective Supervisors or Perspective

Users). Then, click the Properties button at the top of the window.

|| Fie Edit view Help

rf!ﬂ Perspective Workflow Event Manager

JJ-"E; New User | &5 Print | ¥ Delete | E& properties

E vents Subscribers

Subzcribers

EI@ Application Events

.’J Standard Event Pak - Activities

| Standard Event Pak - Admin

4| Standard Event Pak - Agzignments -
i Standard Event Pak - Cases

4| Standard Event Pak - elncidents

| Standard Event Pak - ltems

4| Standard Event Pak - Organizations
| Standard Event Pak - Persons
\g] Standard Event Pak - Vehicles

=8 Subscribers

ﬁ Computers
=58 Uzers

e 5 Perzpective Investigatars
Lo HE Perspective Supervisors

2.  Click the Subscriber Linking button.

in. Perspective Workflow - Perspective Users Properties

]9

=10l x|

Description: |Perspective Users

Subscriber Linking...

Cancel
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3.

Click the Select Query button.

. Perspective Investigators Subscriber Linking - |EI|5|

Subsecrbers of content are stored in the database. Optionally, vou may create a link to subscribers that exist outside of
the databasze. Y'ou must first define a queny that retrieves the subscriber information. 'ou must then must specify
which fields fram the query equate ta fields inzide the subzcriber databaze. Onece the subscribers are linked, the
product will uge the linked information in order to perform content delivery.

Query to use as subscriber content:

Subszcriber Linking Field Definition
Subscriber Field Lirked to Database Field
P | Subsciiber Name =
Last Mamne
First Mame =
Title =
Company Marme
Phone Mumber =
Computer Mame =
IP &ddress =
Ermail Address 1 =
Email Address 2
Pager Teminal Mumber 1 =
Pager Temninal Mumber 2 =
Pager PIN Mumber 1 =
Paager PIMN Humber 2 =
Fax Mumber 1 =
Far Mumber 2 =
‘Weboast Name 1 =
Webcast Name 2 =
Copy Location 1 =
Copy Location 2 =

ak. | Fremaye Subscriter Link... Cancel |
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4.

35

Select the Standard Event Pak - Admin application from the list by clicking on the arrow to
the left of the name; then click the Select button.

i, Perspective Workflow - Select Another Application

=101 %]

Select Anaother Application

Application

Standard Event Pak -

Activities

B tStandard Event Pak -

Adrmin

Standard Event Pak -

Agzignments - General

Standard Event Pak -

Cases

Standard Event Pak -

elncidents

Standard Event Pak -

[tems

Standard Event Pak -

Organizations

Standard Event Pak -

Perzonz

Standard Event Pak -

Wehicles

Select

Cancel
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Select the user query that corresponds to the default subscriber group you selected in Step
1 (i.e., Admin — All Users group; User List — Investigators for the Perspective
Investigators group; or User List — Supervisors for the Perspective Supervisors group).

Then, click the Select button.

. Perspective Workflow - Add Query O] x|
Application: Standard Event Pak - &dmin
Select Anather Application
Lluenes Available For This Application
Query Description Motes -

Admin - &ll Current Logged On Users

B | Admin - All Users

Admin - All Uzerz Role %

Admirn - All Uszers Workgroup =’

Admin - Caze Changes by Admin

Admin - Caze Reads

Admin - Incident Changes by Admin

Admin - Incident Reads

] .

Select Mew Querny...
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6. Inthe Linked to Database Field column on the right, select only the values shown in the

following screenshot and click OK; then, click OK again.

Note: This will link only to each subscriber’s primary email address in Perspective (the email
address that appears in the subscriber’s Person record with the Primary box checked.)

. Perspective Users Subscriber Linking

=101 x|

Subscriberz of content are stored in the databaze. Optionally, youw may create a link o subzcribers that exizt outzide of
the databaze. 'ou muszt first define a querny that retnieves the subscrnber information. ouw must then must zpecify
which fieldz from the query equate ta fislds inzide the subscriber databagze. Once the subscriberz are linked, the
product will uge the linked information in order to perfarm content deliven.

Query to use as subscrnber content:

Adrin - All Uzers

Select Query...

Subzcrber Linking Field Defintion

Subszcriber Field

Linked to D atabasze Field

Subscriber Mame =

Last Mame =

LaztM ame

First Mame =

Firzth ame

Title =

Company Mame =

Phone Hurnber =

Computer Mame =

|P Address =

| Emnail Address 1 -

Email &ddresz 2 =

E mailtddress

Fager Terminal Humber 1 =

Pager Terminal Murber 2 =

FPager PIM Murnber 1 =

Fager PIM Mumber 2 =

Fam Mumber 1 =

Faw Mumber 2 =

“Wehcast Mame 1 =

Webcast Mame 2 =

Copy Location 1 =

Copy Location 2 =

] Hemove Subscnter Link...

Cancel
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Event Configuration

Before using any of the events in your Perspective Workflow event pak, you must complete the

following steps:

. Specify the filter values that each event’s queries will use (if applicable).

. Run each event once using the Schedule This Now option.

. Set each event to "Active" status.

. Select the email account that each event’s alert messages will be sent from.

. Ensure that each event has at least one subscriber with the Email box checked.

. Enter a schedule for each event.

For more information on configuring events, including designing events of your own, please refer
to the Event Designing section of the Perspective Workflow User’s Guide.

1. Inthe Perspective Workflow Event Manager, expand the Standard Event Pak - Cases

node and select Events.

|| Fie Edit view Help

Ifeﬂ Perspective Workflow Event Manager

=191 |

JJ-‘i’jl New Event | Zh Print | < Delete | ‘#. Schedule This Now | ¢ Test This Now

[ 4
°$
3 1

-

E@ Application Events

Standard Ewvent Pak - Activities

4| Standard E vent Pak - Sdmin
.;’J Standard Ewvent Pak. - Azsignments - Genel

Standard Event Pak - Cases
1 Quemys Definitions

Fieport Definitions

-4 1 Scheduled Reports
'0&_!»; Basic Scripts

Standard Event Pak -
Standard Event Pak -
Standard Event Pak -
Standard Ewvent Pak - Persong
Standard Event Pak - Vehicles

Ikems

=8 Subscribers

Camputers
Jsers

-#8 Perspective [nvestigators
-#8 Perspective Supervisors
B Perspective Users

L

-He Management

Application EventshStandard Event Pak

- Cazes\Events

D escription

w

*Caze -

Access Level of '

*Case -

Aocess Level of W' Status v

*Cage -

Case Clozed, Incident Open

“Casge -

Categom '

*Caze -

Count by Case Manager

*Case -

Created in Last ' dayps

*Cage -

Disposition '

“Casge -

Disposition =" Status ™"

*Caze -

List Status

elncidents

*Case -

Mew Cage Created

*Cage -

Momalized Access Level to 1

Organizations

“Casge -

Open for at least ' Days

*Caze -

Review of '

* Case -

otk group "'
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2. Double-click an event in the list on the right.

3. Select the Queries tab. If a question or prompt appears in the Question field at the bottom
of the window, specify the appropriate filter value in the Answer field. You may type the
value in the field, or click inside the field and select the value from a list of available options
using the Browse (...) button that appears.

Note: Only values that have been saved in at least one record in your database will be
available for selection using the Browse (...) button. If you wish to specify a filter value that
is not available, you must type it in the Answer field.

ﬁ Perspective Workflow - Application Events\Standard Event Pak - Cz ﬂ
File Edit Help

[ save and Close i Save and New | » Delete | 4 Previous ~ W Next -

Event Dezcription: Case - Access Level of ‘'

Description  Queries IHepDrtsl Filesl Eu:up_l,l' EmaiII Fa:-:l F'age' WebEastI IMI Au:tiu:unsl Subscrihersl Schedulel Track

[ueriez Selected For Content
Application Cuery Deszcription
Add Query... | B | Standard Event Pak - | Caze - Categaory %'

[~ Use Script instead of Query Script: I Select Senpt,. |
<-Remave Cuery | <<-Remove All Queresz |
Event Trgger Parameters
[uestion Anzwer
& | Pleasze enter a value for dbo_CaseDetails. CaseCategary 3
<< Back Hest = Cancel Help

4. Click Save and Close.
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Select the same event in the list on the right, and click the Schedule This Now button.

n;‘em Perspective Workflow Event Manager o [m] [
|| Fie Edit view neip

JJ-‘i_ﬁNewEvent ‘ & Print ‘ % Delete | ¥, Schedule This Now | ¢ Test This Now

Events
Iif' Ewent b anagement Folders Application Eventz\Standard Event Pak - CazeshE vents
El@ Application Everts Description
; \SJ Standard Event Pak - Activities
! \’J Standard Event Pak - Admin * Case - Access Level of ' Status "
: \SJ Standard Event Pak - Azsignments - Genel * Cage - Case Clozed, Incident Open
EI@ Standard Event Pak - Cases * Case - Category '
""" 3 Quen Defiritions * Caze - Count by Caze Manager
Events * Caze - Created in Last %' dapz
i Feport Definitions * Caze - Disposition '
T :j SCh.EdUIEFl Reports * Caze - Disposition &' Status "
LR Basic Scripts * Caze - Ligt Status =
[]\SJ Standard Event Pak - elncidents * Caze - Mew Caze Created
[]\SJ Standard Event Pak - ltems * Caze - Nomalized dccess Level to 1
E]\SJ Standard Event Pak - Organizations * Casze - Open for at least 's' Days
[]\SJ Standard Event Pak - Persons * Caze - Review of %'
E]---@ Standard Event Pak - Vehicles * Case - Workgroup s

=-#8 Subscribers
ﬁ Computers
=8 Users
----- . Perspective Investigators
ol Perspective Supervizors
¢ Perspective Users
& Management

Subscribers 1| I ﬂ | _'I

Click Yes to confirm you wish to schedule this event to run immediately, and then click OK.

Note: The event will now run, and any existing records in your database meeting the event’s
conditions will be listed under the event’s Tracking tab. By running the event now, before
completing the event’s configuration, you will avoid flooding subscribers’ inboxes with
numerous emails triggered by existing data. After the event’s configuration is complete,
email notifications will only be sent for new data meeting the event’s conditions.

Double-click the same event in the list to open it once again.
If applicable for the event, edit the Event Description to include the filter value(s) you

specified in Step 3 (e.g., Case with Access Level of ‘3’ rather than Case with Access Level
of ‘x).
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9. Check the Active box.

Perspective Workflow - Application Events\Standard Event Pak - Cases\Events

=
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10.

11.

12.

13.

Select the Email tab, and choose an option for the Email Account to Send From field.
(This indicates the account that all email alert messages for this event will be sent from.)

if Perspective Workflow - Application Events\Standard Event Pak - (asa z ﬂ

File Edit Help

[ save and Close i Save and New | > Delete | 4 Previpus ~ ¥ Next -

Event Description: Case - Access Level af '

Descriptinnl E!ueriesl Hepu:urtsl Filesl Copy Email IFaHl F'agel WebEastl IMl .ﬁ.ctiunsl Subsu:ril:uersl Su:hedulel Trac:kl

Awailable values for uze in meszage content:

ItcoessLevell ﬂ

{CazelCategony}

{CazeD escrption} |ze selected /value i Text |
{CazeDisposition}

{CazelD} LI

Email Account to Send From: |[FEE

Email Reply Addrezs [Optional); I

L Lo

Mezzage Subject:

Case with Access Level {[AccessLewvel}

Mezzage Teuxt:

{BECIN“HTML} il
<h3» Case {[CaseNumber}: {CaseNamel}</h3>

<pr<Itrong®

Locess Level: [RocessLewvell

< /atrong></p>

<br f> LI

v Include reports as email attachments., v Include files az email attachments.

[+ Ermail notifications should wait untl reparts are completed.

<< Back Hest > Cancel Help |

If applicable for the event, edit the Message Subject and/or Message Text to include the
filter value(s) you specified in step 3.

Note: Do not edit text enclosed in curly brackets, such as {AccessLevel}. This text will be
automatically replaced by data drawn from the specific record(s) triggering the event.

Configure IM: Select the IM tab, type the IM message to send to subscribers.

Select the Subscribers tab, and then select the Advanced sub-tab.
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14.

43

By default, most events will already have a particular type of Perspective user selected in
the Database Field column (e.g., CaseSupervisorPersonID, InvestigatorPersonlID, etc.).
If so, ensure the Email box is checked.

Note: Subscribers selected under the Advanced sub-tab are specific to the records
triggering the event. For example, in the screenshot below, the CaseSupervisorPersonlD
subscriber will be the specific case supervisor associated with the case record that triggers
the event to run. In other words, each time a different case record triggers the event, a
different case supervisor may be notified.

ﬁ Perspective Workflow - Application Events\Standard Event Pak - Cases ﬂ

File Edit Help

[ save and Close i Save and New ‘ > Delete | 4 Previopus ~ 4 Next -

Event Descrption: Casze - Access Level of &'

Descriptiunl Duerie&l Hepu:urtsl Filesl |:l:l|:l_|,|| EmaiII Fa:-:l F'agel Webl:astl IMI &ction: Subscribers |Schedule Track.

Standard Advanced |

Mezzage Break Field / Databaze Lookup Value

Databaze Field Type E mail Fax Copy Page | 'WebCast
# | CazeSupervizarPersonl D zer E - r | r
Uger Group r - ] r ]

KI 2

Deliver to a specific email, pager, fax or webcast Mame uzing databaze value

Databaze Field Containg thiz walue

3 | Containg Email Address to zend to

Containg Email CC Address to send to

Containg Email BCC Address to zend to

Containg Fax Mumber to dial

Containg Paging Wendor Station Phone Mumber to dial
Containg Pager PIM to page

Containg WebCasting Mame for web delivery

<< Back Hest »» Cancel Help |
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15. To select additional users or groups to subscribe to this event, select the Standard sub-tab.

Note: If there are no subscribers selected under the Advanced sub-tab, you must select at
least one subscriber under the Standard sub-tab.

i. Click Add Subscriber.

if Perspective Workflow - Application Events\Standard Event Pak - Cas ﬂ

File Edit Help

[ save and Close i Save and New | > Delete | 4 Previous ~ W Mext -

Ewvent Description:  Case - Access Level of s’
Descriptiu:unl Bueries' Hepu:urtsl Filesl Eu:up_l,ll EmaiII FaHI F'agel WebEastI IM| Actionz  Subscribers IS::heduIeI Track.

Standard |.ﬁ.dvanced|

e . |

|Jzerz Targeted For Deliverny
ISuI:usu:riI:uer IT_I,IpE I Ermnail I Fax I Copy I Fage I'w'el:uCast I It I

Computers Targeted For Delivery
I Subszcnber Type I Copy %]

KN i

<-Remove Subscriber | <<-Remove All Subscribers |

<¢ Back Mewt x> | Cancel | Help |
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ii. Check the boxes for all individual subscribers and/or groups you want to receive email
alert messages for the event; then, click Add Subscriber.

. Perspective Workflow - Add Subscribers |

Place a checkmark nest to the subzcrber or group to notify

= Subzcribers

El-[] Computers
[ Management

E- ] Users
[] Management
[] Perspective Investigators
[] Perspective Supervizors
E-[] Perspective Users

Smith, Jane

Add Subscriber Cancel
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Ensure the Email box is checked beside each subscriber’'s name.

if Perspective Workflow - Application Events\5Standard Event Pak - (asa_:' :
File Edit Help

[ save and Close g Save and New | X Delete | 4 Previpuzs ~ 4 Next -

Ewvent Description: Caze - Access Level of '

Descriptiu:unl Queriesl Hepu:urtsl Filesl |:l:l|:l_','| EmaiII Fa:-:l F'agel 'W'el:uEastI IMI Actionz  Subscrbers |Schedule| Track

Standard | .&dvancedl

T |

|Jzerz Targeted For Deliveny
Subzcriber Type E mail Fax Copy | Page | ‘webCast | Ik
| Smith, Jane Llzer v [ ] F I v
Computers Targeted For Delivery
I Subzcriber | Type I Copy I Ik
kI i
<-Remove Subscrber | <<-Remove All Subscribers |
¢ Back Mewut »» | Cancel | Help |
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16. Select the Schedule tab.

a. Select an option for the Choose a schedule to use field (e.g., Every Hour, Every
Monday at 9:00 AM, etc.).

if Perspective Workflow - Application Events\Standard Event Pak - C ﬂ
File Edit Help

[& save and Close || Save and New ‘ ¥ Delete | 4 Previouzs = 9 Next -

Event Description: Case - Access Level of '

Descriptiunl Dueriesl Hepu:urtsl Filesl D:upyl Emaill Fa:-:l F'agel 'W'el:uEastl IMl .ﬂ.ctiuzunsl Subzcribers  Schedule |Trau:k

Chonze a zchedule to uze: |[SENEIl ol LI

Edit This Schedule.. | . |

— Scheduling Information:

Frequency:Every n Minutes, Minutes &
Allowed Days: Sunday Monday Tuesday Wednesday Thursday Friday S aturday
Allowed Monthe) anuary February bMarch april May June July August September October Movember December

=

Y

v Should this run on a haliday

Add Dependency...

The current event will be triggered if the following event(z] are tiggered:
I Application I Event Description I
{-Remove Dependency | £<-Remove All Dependencies |
<< Back Mest = | Cancel | Help

OR
b. Click the Create New Schedule button.
i. Inthe Schedule field, enter a description for your new schedule.

ii. Inthe Should not run until after date/time field, enter a future date when events
using this schedule will begin to run, or leave the field blank if you want the
schedule to be activated immediately.
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In the Frequency field, choose an option for the schedule’s rate of recurrence (e.g.,
Every n Minutes, Daily, Weekly, etc.); then, in the new field that appears below,
specify additional details for the frequency, such as the time of day for the event to
run or the day of the week.

Perspective Workflow - x|
File Edit Help
E Save and Close | ¥ Delete | 4 Previous ~ 4 Next -
Schedule: The 1st of Every Manth at 00:01
Dezcription T Allowed Fange T Higtam ]
Internal [0 number: |25
Schedule: |The 1zt of Every Month at 00:01
Should not run unkil after datetirme: I
— Frequency Information;
Frequency: IMDnthl_'r' j
Day OF The Manth |-| j
D il e to roe ||:||:|;|:|1|
Motes:

48




Perspective Workflow Installation Guide

iv. Under the Allowed Range tab, specify the months of the year, days of the week
and hours of the day that the event is eligible to run. (Times are inclusive.)

Perspective Workflow -

File Edit Help

[ save and Close | » Delete | 4 Previous v W Next -

Schedule: The 1zt of Even Month at 00:01

Description | A

— Schedule will run on the following months:

v January v tayp v September
v Februany v June v October

v March [v July v Movember
[v &pril v August v December

— Schedule will run on the following days:

[~ Sunday v wWednesday [~ Saturday
v Monday v Thursday
v Tuesday v Friday
Draily range begin tirme: I‘I 2:00:00 Ak Daily range end time: |11:59:00 P

v. Click Save and Close.
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17. Click Save and Close. The event is now activated and will run according to the specified
schedule alerting the subscribers indicated.

ﬁ Perspective Workflow - Application Events\Standard Event Pak - C

File Edit Help

[ save and Close |a Save and New | > Delete | 4 Previous ~ W Next -

Save the current item and dose the window | »
CVENT DEECNPNOT, Caze - mocess Level of s

Descriptiu:unl Dueries' Hepu:urtsl Filesl EDp_I,II EmaiII Fa:-:l F'agel WebEast' IMI .-“-‘-.u:tiu:unsl Subscribers  Schedule |Track

Choose a schedule bo uge: |The st of Every Month at 00:07 4

Edit This Schedule. | | Create New &ohaduis. |

Scheduling |nformation:

Allowed Days:Monday Tueszday wWednesday Thureday Friday

Frequency:Monthly, Day Of The Month 1 Daily time to run 00:01 ﬂ
Allowed Monthz:danuary February March April M ay June July August September October Movember December

[+ Should this run on a haliday
Add Dependency. ..
The curent event will be triggered if the following event(z] are tiggered:
I A pplication I Ewent Description I

<-Remaove Dependency | <<-Aemove All Dependencies |

<< Back Hest > | Cancel | Help

18. Continue to apply these steps to all events you would like to activate.
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Contact Information

Technical Support

Toll Free: 1-877-776-2995

Phone: (780) 448-0616

Email: support@ppm?2000.com

PPM 2000

Toll Free: 1-888-PPM-9PPM (1-888-776-9776)
Phone: (780) 448-0616

Fax: (780) 448-0618

Email: information@ppm?2000.com
Website: www.ppm2000.com
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